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Neue SpatialAnalyzer Version:      SA 2012.12.06 

Aktuelle Weiterentwicklungen 

  

Download:   http://www.kinematics.com/download/index.php 

  

 
 

• Integration anderer Sprachen 
 

Fünf Sprachen sind von jetzt an in der SA Benutzer- 
oberfläche integriert, zwischen denen einfach 
 gewechselt werden kann: 

Englisch 
Deutsch 
Spanisch 
Russisch 
Chinesisch 

 
 

 

• Selectiver CAD Import  
 

Bei CAD Formaten, die einzelne Bauteile unterstützen (z.B. CATIA CatProduct Dateien),  
können Sie nun Auswählen welche individuellen Komponenten eines Bauteils sie  
importieren möchten, anstatt  
das gesamte Bauteilmodell zu  
importieren.  
Die Bestandteile jeder CAD  
Datei werden vor dem Import  
angezeigt, so dass Sie aus- 
wählen können, welche Teile  
Sie übernehmen wollen. 
 
Um diese Auswahlmöglichkeit 
zu nutzen, verwenden Sie bitte  
beim Import einer CAD Datei  
die Funktion Direct CAD Access.  
 
Hierfür muss im Direct CAD  
Access Dialog zudem die Option 
Selective Import (Choose  
which Components to  
Import) aktiv sein.  

Bitte beachten Sie: Es handelt sich dabei um eine Vollversion, die allerdings nur mit einer aktuellen 
Softwarelizenz über den vollen Funktionsumfang verfügt. Ansonsten kann sie als Viewer verwendet werden.  
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• GD&T Optimierungen 
 

 Kontrolle des „Pre-Eval Validator“ 
 
 Im Analyse Reiter (Analysis tab) der Benutzereinstellungen      ,  
 kann über den Button GD&T Options im GD&T Optionsdialog  
 der neue „Pre-Eval Validator“ gewählt werden. 
 Darin sind  spezielle Standards für die Bewertung von Messdaten  
 vorrangig für GD&T –Berechnungen aufgeführt.     
 
 In Abhängigkeit vom aktivierten Standard (ASME 1994,  
 ASME 2009, ISO 1983 oder ISO 2004), können verschiedene 
 Überprüfungen der Ausgangsdaten ausgeführt werden. 
 Dies kann zu einer nicht erfolgreichen Überprüfung führen  
 (check failed), selbst wenn diese in einer früheren SA Version  
 erfolgreich war (check passed). 
  
 Achtung: Die None-Option behält die entsprechenden  
 Einstellungen der früheren SA Versionen bei. Diese Einstellung  
 wird mit der SA Vorlagedatei gespeichert. 
 
 

 Neuberechnung aller „Feature Checks“ 
  
 Eine neue Option zur zwingenden Neuberechnung aller Merkmalsüberprüfungen (Feature Checks) in der gesamten 
 Datei wurde hinzugefügt. Hierfür einfach die Funktion GD&T > Evaluate All Feature Checks ausführen. 
 

 
• Punkt zu Objekt Bemaßungen: Radiale Offsets 
 

Punkt zu Objekt Bemaßungen können nun zusätzlich zu  
planaren Offsets auch radiale Offsets kompensieren. 
Einfach die Use Radial Offset Component Option aktivieren.  
Dies ist beispielsweise hilfreich, wenn der Abstand zu einer  
Kante abgefragt wird, die wiederum mit einem Kantenadapter  
gemessen wurde. 

 
 
 
 
 

• Setzen einer Ansichtsrichtung  (View>View Control>Set Viewpoint … ) 

 
 Von einem Objekt aus (… >From Object) 

 Die Ansichtsrichtung wird entlang der -Z Achse eines ausgewählten Objektes gelegt. 
 

 Von einem Oberflächenpunkt aus (… >From Surface Point) 
 Die Ansichtsrichtung wird direkt entlang der Normalenrichtung auf eine Fläche (surface) zu einem 
 bestimmten Punkt, der auf der Fläche angeklickt wird, ausgerichtet.  
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•  Report-Verbesserungen 
 

 Gestaltung 
 Durch Zeichnen von Boxen, Ellipsen und Linien (oder auch Pfeilen), können wichtige Informationen in den Reports 

hervorgehoben werden. Verwendbar sind alle Farben oder auch mehrere verschiedene Linienstärken und Stile.  
 
 
 
 
 
 
 
 
 
 
 
 

 
 Objektsperrung 

 Einzelne Reportelemente können nun gesperrt werden, wodurch die Werte “eingefroren” werden, damit sie im 
Report Designer nicht verändert werden können. Zum Einschalten des “Gesperrt” Status, genügt ein Rechtsklick auf 
das Objekt im Report und die Auswahl von “Lock Object” im Kontextmenü. 

 
 Zurück-Funktion 

 Die Funktion Edit>Undo bzw. der Shortcut Ctrl+Z wurde im Report Designer hinzugefügt.  

 
 Seiten einfügen/ löschen 

 Mittels Rechtsklick im SA Report können einzelne Seiten: 

• … eingefügt werden, wenn keine Reportelemente die horizontale Linie schneiden auf der der Klick  
        ausgelöst wurde.  
• … gelöscht werden, wenn die Seiten keine Reportelemente enthalten.  

 

 Unterdrücken der Tabellenverkürzung 
 Die Verkürzung von einzelnen Tabellen  
 kann nun durch Rechtsklick auf die  
 Tabelle und die Auswahl von Do Not 
 Truncate aus dem Kontextmenü  
 unterdrückt werden (ungeachtet der  
 Einstellung bei Maximum Number of  
 Rows Per Table im Reporting Tab der  
 Benutzereinstellungen). 
 

 Leere Seiten am Reportende entfernen 
 Im Report Designer wurde die Funktion  
 Edit>Remove Trailing Empty Pages 
 hinzugefügt, um alle leeren Seiten 
 am Ende eines Reports zu entfernen. 
 

 Einfärben der Felder von Deltawerten die 
    sich „Innerhalb der Toleranz“ befinden 

 Diese neue Reportoption wurde in den  
 Elementeinstellungen integriert  (siehe Bild). 

mailto:spatialanalyzer@vmt-gmbh.de?subject=ABMELDUNG_SA_Release_Newsletter
mailto:spatialanalyzer@vmt-gmbh.de
mailto:spatialanalyzer@vmt-gmbh.de
mailto:spatialanalyzer@vmt-gmbh.de
http://ims.vmt-gmbh.de/
http://ims.vmt-gmbh.de/
http://ims.vmt-gmbh.de/


Wenn Sie diesen Newsletter von uns zukünftig nicht mehr erhalten wollen, dann klicken Sie bitte auf folgenden Link: Abmeldung_SA_Release_Newsletter 
 

VMT GmbH - Gesellschaft für Vermessungstechnik, Stegwiesenstraße 24, 76646 Bruchsal – Deutschland | Tel.: +49 (0)7251-9699-8333 | Fax: +49 (0)7251-9699-8491 |  

Email: spatialanalyzer@vmt-gmbh.de | http://ims.vmt-gmbh.de | Geschäftsführer: Dipl.-Ing. (FH) Manfred Messing | Registergericht Mannheim HRB 231601 | Ust-IdNr. DE 163494957 
 

© 2012 VMT GmbH, Nachdruck oder Vervielfältigung auch auszugsweise nur mit schriftlicher Genehmigung der VMT GmbH. 

• Laser Tracker 
 

 Projection Plane Settings / Projektionsebene einstellen 

 Für Messoperationen die Projektionsebenen unterstützen wurden neue Einstellmöglichkeiten integriert.  

 Dies betrifft die Profile:    Circle  /   Patch Point  /  Single Point Circle 
 
 Mit einem Linksklick auf die Auswahlparameter  der zu  verwendenden  
 Ebene, lassen sich die Projektions- und die Verschneidungsoptionen  
´ einer Ebene einstellen. Mittels Rechtsklick lassen  sich Optionen für das 
 automatische Fitten der Punkte während der Messung festlegen: 

• Regenerate in SA. Diese Option erstellt die konstruierte Ebene  
   automatisch nachdem das Profil fertiggestellt wurde.  

• Remove from Profile. Trennt eine ausgewählte Ebene vom Profile. 

• Fit To Points. Bei Auswahl fittet SA  automatisch eine Ebene in die  
   gemessenen Punkte. Hier wird zudem die zu messende Anzahl von Punkten festgelegt.  
 
 

 3-Plane Point / Punkt aus 3 Ebenen 

 Diese neue Messoperation in der Lasertracker-Schnittstelle automatisiert den  
 Messprozess eines „Eckpunktes“ - ein Punkt der durch drei sich schneidende  
 Ebenen konstruiert wird.  Diese Operation kann bei verschiedenen Acquisition  
 Modes verwendet werden, inkl. Discrete Point, Stable Point, und Spatial Scan.   
 Siehe “Projection Plane Settings” zum definieren oder messen der drei Ebenen. 
 
 

Targets mit kundenspezifischen radialen Offsets hinzufügen 

 Beim Hinzufügen von definierten Targets in der Lasertracker-Schnittstelle mit   
 dem Button Add: From Selected Reflector, können nun gleich beide Offsets  
 (planar und radial) definiert werden, anstatt wie früher nur in der Targettabelle. 
 Die Default-Werte in diesen Feldern ändern sich in Abhängigkeit von der Größe  
 des ausgewählten Reflektors und der aktuell eingestellten Einheiten. 
 
 

 Circle Fit Point on Normal Option 

 Wenn ein Kreis in der Lasertracker-Schnittstelle oder mittels Measurement Plans 
 gemessen  wird, haben die Ausgabeparameter eines Kreisfits nun die Option  
 Make Pt on Normal. 
  
 Bei Auswahl von Make Cardinal Pts,  
 wird durch das Fitten ein Hauptpunkt  
 (Cardinal Point) auf der Kreisnormalen 
 erstellt.  Nun kann diese Option  
 deaktiviert werden, um nur den Haupt- 
 punkt im Kreismittelpunkt zu erzeugen. 
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•  Navigationsverbesserung in der Inspektionsroutine  
Die Funktionstasten (F-Tasten) können nun mit den Operationen “Next”, “Previous”  
und “Stop” belegt werden. Dies dient vorrangig der erleichterten Navigation in der  
Inspektionsroutine des SA Toolkits. 

Zusätzlich können jetzt auch die Tasten eines Messarms mit Next/Previous  
(entspricht einem kurzen/langen Drücken der Tasten) belegt werden. 

 
 
 
 
 

• Leica AT-401 Reflector Tilt Detection 
Beim AT401 wird mit EmScon v.3.8.290 und höher nun 
erkannt, ob der Reflektor zu stark gegenüber dem  
Instrument verdreht ist. Es wird  dann ein ungültiger  
Status des Messstrahls zurückgemeldet, um weitere  
Messungen zu verhindern. 
 
Die Funktion Reflector Tilt Detection kann in den  
Trackereinstellungen (Leica 4xx Tracker Settings Dialog)  
ein- und ausgestellt werden.  

 
 
 
 
 
 

• Laser Radar: Auswahl der Videoquelle 
In der Schnittstelle des Laserradars kann nun mittels Settings>Video Settings> 
Video Capture Device die Videoquelle gewählt werden. 
 
 
 
 
 

• Leica TDA5005 GeoCOM Interface  

Eine auf GeoCOM basierende Schnittstelle für den Leica TDA5005 wurde hinzu- 
gefügt, wodurch nicht mehr die eingebettete SA Anwendung von NRK verwendet  
werden muss. Die neue Schnittstelle sieht aus wie die des TDRA6000. Das  
Instrument muss jedoch als Typ ‘Leica TDA5005 Total Station (GeoCOM)’  
hinzugefügt werden. 

Damit im GeoCOM Modus gearbeitet werden kann, muss das Instrument im  
Hauptmenü im ‘MEAS’ –Programm laufen.   

Der TDA5005 sollte folgendermaßen konfiguriert werden: 

 - mit GSI Kommunikation: 9600/N/8/1/No Protocol  
 - mit GeoCOM Kommunikation: 9600/N/8/1/GeoCOM Protocol. 
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•  Wiederholen von Ausrichtungen 
 
Jede Instrumenten-Ausrichtung kann nun wiederholt werden, wodurch Ausrichtungen als Teil eines wiederkehrenden Prozesses 
deutlich vereinfacht werden.   
Wie auch immer ein Instrument ausgerichtet wurde (entweder durch Quick Align, Measure Nominal Points oder Frame Wizard), 
die Ausrichtungsparameter werden mit dem Instrument abgespeichert und die Ausrichtung kann zu jeder Zeit wiederholt werden.  
 
Eine Instrumenten-Ausrichtung wiederholen:  
Ein Klick auf den Repeat Last Button im Inspection Tab  des SA Toolkits, während die Verbindung  
zu einem Instrument besteht, genügt. Automatisch werden die zuvor gespeicherten Ausrichtungs- 
parameter aufgerufen, die dann noch geändert werden können. 
Eine neue Ausrichtung eines verbundenen Instruments kann am besten mittels Klick auf den  
New Button ausgeführt werden. 

 
 
• Geometry Relationship  - Punktlisten 
 
Nun haben Sie Zugriff und Kontrolle über die Punktlisten im Geometry  
Relationship – ein einfacher Klick auf den Button Point List in den Optionen des  
Geometry Relationship Reports genügt.  
 
Ebenfalls Zugriff auf die Punktlisten erhalten Sie durch Rechtsklick auf ein  
Geometry Relationship in der SA Baumstruktur und Auswahl von View Point List.  
Wie im Geometry Fitting Dialog können Punkte deaktiviert, Punkte bei  
Überschreitung eines kritischen Schwellwertes ausgeschlossen und nach Namen 
oder Fehlern sortiert werden.  
 
Eine neue Option wurde zu den Geometry Relationship Report Options hinzu- 
gefügt, durch die die Punkte im Report angezeigt werden.  Hierfür muss nur die 
Option Show Point List Details In Report ausgewählt werden. Wenn das Geometry  
Relationship  im Report hinzugefügt wird, dann ist die Punktliste automatisch mit enthalten. 
 
 

• MP Script 

 Suche  

Der MP Editor hat nun ein Suchfeld (Search), um das aktuelle Script nach  
Kommandos oder Kommentaren zu durchsuchen. 

Dies kann bei langen, umfangreichen Scripten eine Menge Zeit sparen. 

 

 Der MP Editor unterstützt nun das Laden von MPs aus externen Dateien mittels  
    Drag and Drop Funktion.  
 

 Der neue Button Show Step References wurde hinzugefügt, wodurch die  
    Referenzschritte eines ausgewählten Schrittes angezeigt werden.  
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•   Events – Rückblick 

4. Deutsches Anwendertreffen der SpatialAnalyzer Software 

08. – 09. November 2012 | Bruchsal - Germany | VMT GmbH 
 
In diesem Jahr hielten sechs SA Anwender Vorträge über Ihre Arbeiten mit SpatialAnalyzer. 
VMT und NRK präsentierten die neuen SA Pakete (siehe unten) und organisierten 
Workshops zu den Themen „Relationship Fitting“ und „Toolkit + Reporting“. Vielen Dank 
an die Vortragenden und die 45 Teilnehmer am deutschsprachigen Anwendertreffen. Wir 
freuen uns auf ein zahlreiches Wiedersehen im neuen Jahr. 

SA PROFESSIONAL 
SA PROFESSIONAL mit Native CAD ist die professionelle Software für Vermessung, Ausrichtung, Prüfung, Analyse 
und Protokollierung mit allen portablen Messinstrumenten. Zusätzlich zu allen wichtigen Messanforderungen 
enthält sie auch mehrere Schlüsselfunktionen für Inspektion, Geometrieprüfung und Messautomatisierung. 
 
SA ULTIMATE 
SA ULTIMATE mit Native CAD ist die führende Software für Messung, Optimierung, Analyse, Protokollierung und 
Automatisierung passend für alle portablen Instrumente. 
 
SA MACHINE 
Beinhaltet SA Ultimate und NATIVE CAD, Interface zu Robotern und CNC-Maschinen, Kalibrierung und Echtzeit-
Kompensation, Robotersteuerung, Kontrolle von linearen oder Gelenkarm-Robotern, Analyse der Denavit-
Hartenberg-Parameter, volle inverse Kinematiken, grafische Simulation. 
 
Für weitere Informationen:  VMT IMS Homepage 
   NRK Homepage 

•   Verfügbare SA Pakete 2013 

•   Events – Vorblick 

CONTROL 2013  
Die Internationale Fachmesse für Qualitätssicherung 

14. – 17. Mai 2013 | Messe Stuttgart | Halle 5, Stand 5308   
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